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I. Introduction

The purpose of this document is to assist in the preparation of professional or academic papers. I

originally produced this guide for students of mine, partly to allow me to refer them to it rather than

have to teach all of it. It was written especially for political scientists and students of public

administration, but many of the points covered will apply to students in other disciplines as well. 

Important Caveat: In one sense this guide is rather generic. As such, short of any other information, it

should serve very well in the preparation of professional or academic papers. However, different

professors (or journals) often have their own requirements. It should go without saying that this guide

was not written to contradict any of these requirements. 

Another Important Caveat: By no means is this a complete style guide. There are many other

resources available to help you improve your writing. Most universities, for example, have free

writing clinics and centers. Take advantage of them!
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II. Formatting Your Paper

The following are guidelines for formatting your paper, or in other words, what it should look like.

Most assume some basic knowledge of personal computing. 

1. All work should be word-processed only. This means no pen or pencil marks should be present

anywhere on your paper, for any reason, ever. If you make a mistake, you should re-print the paper.

2. Use only regular (not italic, not bold) 12-point font only. Acceptable font faces include Times New

Roman or Arial, but as a rule, Times New Roman is probably the better choice. 

3. All papers of more than one page should have pages numbers. 

C In Microsoft Word, from the menu: Insert => Page Numbers

4. Your paper text should be double spaced throughout. 

C In Microsoft Word, from the menu: Format => Paragraph => Line Spacing.

5. Your paper should have one inch (1") margins all around: Top, bottom, left and right. 

C In Microsoft Word, from the menu: File => Page Setup => Margins.

Note: Many People, for Some Peculiar Reason, Never Check This. You Should!

6. Your paper should be “left” aligned, not “justified.” Alignment refers to the way the edge of the

text is lined up. To be specific, the right side (edge) of the text in your paper should be uneven, not

straight. 

C In Microsoft Word, from the menu: Format => Paragraph => Alignment.

7. With several exceptions, all paragraphs should have the first line indented five spaces; this should

be done using the TAB key on your keyboard. The exceptions to this rule include the abstract, block

quotes, titles and headings, subheadings, references, table titles, notes, and figure captions.

8. Use a single space after sentence terminators (periods, question marks, exclamation points). 

9. All papers of more than one page should be stapled – not glued, paper clipped, or placed in special

folders or binders. If you do not own a stapler you can find one in just about any office on campus.



Page -3-

III. Page Order & Page Descriptions

The elements of the papers should be written and ordered as follows. Several are discussed in greater

detail below. 

C Title page.

C Abstract (if required).

C Body.

C References.

C Appendixes (if any).

C Endnotes (if any).

C Tables (if any).

C Figures (if any).

1. Title Page 

The title page is page 1 in your document. Below are the key elements of a title page, in the order in

which they should appear:

C Paper Title: Uppercase and lowercase letters, centered on the page

C Author (Or Authors): Uppercase and lowercase letters, centered on the line following the title

C Institution Affiliation or Course Information: If you are submitting the paper to an outside

audience (e.g., a journal), your institutional affiliation is necessary. If it is a class paper,

include the course information. In either case, this should be uppercase and lowercase letters,

centered on the line following the author(s). 

C The Date: Uppercase and lowercase letters, centered on the line following the institutional

affiliation or course information. 

2. Abstract 

The abstract is a one-paragraph summary of the most important elements of the paper. Some points

about abstracts follow: 

C An abstract should not exceed 150 words. 

C The abstract begins on a new page (page 2), and begins with the word “Abstract.” 

C The abstract itself, in block format (indented) begins on the following line. 

C All numbers in the abstract (except those beginning a sentence) should be typed as digits

rather than words. 

3. Body 

This is the actual paper itself. 

C The body of the paper begins on a new page following the abstract. 

C The title of the paper (in uppercase and lowercase letters) is centered on the first line. 

C The introduction begins on the line following the paper title. 

C Headings are used to organize the document and reflect the relative importance of sections;

the section may have subheadings as well. Subsections do not begin on new pages. 
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IV. Paper Organization & Development

This section covers several structural aspects of writing a good social science research report. It

includes (1) making an outline; (2) writing a good introduction; (3) making use of section headers;

and (4) writing your conclusion. 

1. Making an Outline

A good paper needs a plan; that is what an outline is. From your notes about the subject and your

thoughts, organize a plan for the paper and write (or type) it down in outline form. Virtually all papers

will have at least three sections: An introduction, a section (or more) making your point, and a

conclusion. Below is a very simple example (which I will build on throughout the next few sections): 

TITLE: PRESIDENTIAL GOVERNMENT 

I. Introduction 

II. Functions of Presidents 

1. Presidents As Head of State 

2. Presidents As Head of Government 

3. Examples: Presidencies in the United States, France, Russia 

III. Conclusion 

Important: Outlines can, and often do, change, but starting out with one helps organize your thoughts. 

2. Writing a Good Introduction

Remember first that social science research reports are not mystery novels: Tell the reader right away

what the paper is about. At minimum, a good introduction should have: 

A. The Thesis 

A Brief Summary of the Paper. This is a one-sentence summary of your paper. It is your main point –

what you hope the reader will remember a week after having read your paper. 

EXAMPLE: “This paper shows that there is great variation in the functions and powers of

presidents in presidential systems.”

B. An Explanation of How You Will Illustrate Your Thesis (Make Your Point)

Here you basically list the sub-sections in your paper in written form. It is the plan (organization or

structure) of the essay. This should be easy to do if you have done an outline.

EXAMPLE: “The paper is organized as follows. The following section examines the

functions of presidents and includes a discussion of the president as head of state, the

president as head of government, and examples of each from the United States, France, and

Russia.”
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3. Making Use of Section Headers

Section headers do at least two things. First, they make it easier for your reader to follow (read).

Second, and easily as important, they make it easier for you to write a coherent and well-developed

research report. You can utilize section headers any way you want, but one easy way to do it is to start

writing your paper by using your typed outline. Again, changes to the outline (plan, or organization of

your paper) can be made as you develop your paper, but this is an effective way to keep your thoughts

organized as you go. Using the outline presented above, your paper might look something like this.

“Presidential Government”

I. Introduction 

[Your text is here]

II. Functions of Presidents

[Your text is here] 

1. Presidents as Head of State

[Your text is here] 

2. Presidents As Head of Government

[Your text is here]

3. Examples: Presidencies in the United States, France, Russia

[Your text is here]

III. Conclusion 

[Your text is here]

Generally, main section headers are in bold, and sub-section headers are in italics or underlined.

Some people use all upper-case letters (capital letters) for main headers. The important thing is that

however you decide to format headers, be consistent!

4. Writing Your Conclusion

All research reports should have a conclusion that is, at minimum, three paragraphs in length. It

should include the following three elements: 

A. Re-state the Thesis of the Paper

Basically this means saying what you said in the introduction over again, using slightly different

words (and in the past tense). 

EXAMPLE: “In this paper I have shown that there are many differences in the functions and

powers of presidents in different countries.”

B. Briefly Re-state Other Pertinent Facts That You Revealed. 

EXAMPLE: “The power of presidents as head of state seems to be similar in all three

countries. But the power of the president as head of government is much greater in Russia

than in either France or the United States. And, in all countries, the power of the president as

head of government seems to be greater in foreign affairs than in domestic affairs.”
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C. Make a Point or Two about the Implications of Your Conclusions

This is what separates political (social) scientists from journalists and where you add your voice.

What does it mean? Why should we care? Why is this topic important?

EXAMPLE: “Giving presidents greater power in foreign policy was intentional in all three

countries; checking presidential power in domestic affairs was also no accident. But since

domestic affairs are increasingly affected by international politics, presidential power in

domestic affairs may be increasing while checks on that power might be decreasing.”

5. Elements of Good Writing, Part I

These are three rules about actually writing your paper that most writing instructors will stress —

things to keep in mind throughout the process. 

A. Focus: Keep your thesis in mind and keep referring back to it to make and re-make your point. 

B. Development: Remember that in order to make your point, you must make a logical argument and

back it up with evidence. 

C. Coherence: This means, simply, does your paper make sense? Does it all fit together? This is

actually something you would check when your paper is finished, in editing (see the following

section). 

6. Elements of Good Writing, Part II: Rewriting

Finish your paper early. Then look at it the next day to check it. Fix any mistakes: You will find

some, I can assure you. Do this again the next day, and even one more time if you can. Good writing

means rewriting and revising — even for the best writers. 

Again: Proofread, proofread, proofread: Most people cannot proofread their papers too often!

7. Elements of Good Writing, Part III: Have Someone Else Proof

Most universities have free writing clinics and centers. Take advantage of them! Ask your

university’s writing center to proof your paper after you do. 
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V. Creating Professional Tables

There are several guides, some formal, some informal, to follow when creating a table in a

professional paper. They are listed below, followed by a generic example. 

1. You should use horizontal lines only. Do not use vertical lines except in a rare case where your

table might need to be split in half (for example, presenting two series of the same data). 

2. Your tables should be single spaced, not double spaced (like the rest of your paper). 

3. You should number your tables and have a descriptive table title for each. Both should be in bold

font. 

4. Generally, column and row heading should be regular or italic font; do not use bold font for

column or row headings. 

5. All tables should be full-page width. 

6. At all costs, avoid having tables run longer than one page. If you have an especially long table, you

might try formatting as “landscape” (in Page Setup), or, reduce the font size (however, you should

probably not use a font size smaller than 8 point). 

7. The source(s) of the information contained in the table should be immediately below the table, in

10 point font. 

8. If there is one note (something the reader must know about some element of your table), use an

asterisk; if more than one, use superscript numbers (e.g., 1). 

EXAMPLE: Table X. Table Title Goes Here*

Row Category 1 Row Category 2 Row Category 3

Column Category 1 (Data) (Data) (Data)

Column Category 2 (Data) (Data) (Data)

Column Category 3 (Data) (Data) (Data)

Column Category 4 (Data) (Data) (Data)

Column Category 5 (Data) (Data) (Data)

Total (If Applicable) n=100 n=100 n=100

Data from Johnson (2004). 

* This is a note to tell the reader something important about the table. 
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VI. Style: In-Text Citations

You must document, or cite, any information, theories, ideas, etc., that you use, including seemingly

obvious facts (remember than in science, there is very little “common knowledge”). In practical

terms, this means that you will usually have at least one citation (or more) on every page. There is one

exception to this rule of thumb: Lecture notes need not – should not – be cited in your paper. 

Citations provide information to lead the reader to the accompanying bibliographical entry. Complete

information about each source cited in the text must be supplied in a list called “References” found at

the end of the research paper. A general citation contains two elements; a citation referring to a

specific portion of the publication contains three elements. 

1. General: Author’s Last Name

C Use the author’s last name only in the citation. 

C If there are two or three authors, include all (“Brown and Smith,” or, “Brown, Smith, and

Jones”); if more than three authors, use the first author’s last name followed by “et al.”

(Brown, et al.”). 

C If you have more than one work by authors with the same last name, provide initials (before

the last name, not inverted order) for each author in the text and in parenthetical citations.

C If there is no author, use the title of the work, shortened. 

2. General: Year of Publication

C The author’s name is followed by a comma, then the year of publication (Brown, 2004). 

C Do not include months or days, even if these are given in the Reference list.

C If there is no date of publication (as is the case with some Internet sources), write “no date” or

“n.d.”

3. Specific: Page Numbers or Chapters

C Page numbers or chapters are not needed in a citation unless you are referring to a specific

portion of a publication. 

C If referring to a page or pages, a colon and the page number(s) follow the date (Brown,

2004:234-56). 

C If referring to a chapter or chapters, a comma and the chapter or chapters follow the date

(Brown, 2004, Ch. 4).

Following are several examples. They do not cover every eventuality, but serve to illustrate the basics

of in-text citation style. 

A. General Citations: Refers to the Entire Publication

One Author, Version 1

“As Johnson (2004) noted, most research in this field has been limited to case studies.”

One Author, Version 2

“As one scholar (Johnson, 2004) noted, most research in this field has been limited to case studies.”
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Two Authors, Version 1

“As Johnson and Smith (2004) note, most research in this field has been limited to case studies.”

Two Authors, Version 2

“One well-known text (Johnson and Smith, 2004) suggests that most research in this field has been

limited to case studies.”

Three Authors, Version 1

“As Johnson, Smith, and Brown (2004) note, most research in this field has been limited to case

studies.”

Three Authors, Version 2

“One well-known text (Johnson, Smith, and Brown, 2004) suggests that most research in this field

has been limited to case studies.”

More than Three Authors, Version 1

“As Johnson, et al. (2004) note, most research in this field has been limited to case studies.”

More than Authors, Version 2

“One well-known text (Johnson, et al., 2004) suggests that most research in this field has been limited

to case studies.”

No Author

“One well-known study (“Research Note,” 2004) suggests that most research in this field has been

limited to case studies.”

B. Specific Citations (All Are Given as Single-author)

Reference to a Specific Page

“As Johnson (2004:24) noted, most research in this field has been limited to case studies.”

Reference to Several Consecutive Pages

“As Johnson (2004:24-28) noted, most research in this field has been limited to case studies.”

Reference to Non-consecutive Pages

“As Johnson (2004:24-28, 78-98) noted, most research in this field has been limited to case studies.”

Reference to a Chapter

“As Johnson (2004, Ch. 4) noted, most research in this field has been limited to case studies.”
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C. Quotations

If you quote from another’s work, you must provide your reader with the specific page or pages (or

note) you are referring to. Note that the end quotation mark comes before the reference, and, the

period follows the end parenthesis.

Example #1

One well-known scholar noted that “most research in this field has been limited to case studies”

(Johnson, 2004:24).”

Example #2

“One well-known scholar noted that “most research in this field has been limited to case studies”

(Johnson, 2004, footnote 4).”

You should avoid using a quote from one scholar found in another scholar’s work. If you must do so,

reference the publication you found the quote in. 

Example

As Johnson noted, “most research in this field has been limited to case studies” (Brown, 2004:24). 

D. Reference to More than One Publication, Single Citation

If you need to refer to more than one publication in a single citation (not uncommon), separate

references by a semi-colon. 

Example (Single-author, General)

“As several scholars (Johnson, 2004; Smith, 2003; Brown, 2002) have noted, most research in this

field has been limited to case studies.”

Follow the above guidelines for multiple authors and specific references if needed. 
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VII. Style: Reference Lists

All papers need a bibliography, titled “References.” All of the works that you reference in your paper

must be included in this bibliography, even though they have been cited already. Your reference list

should be alphabetized by the last name of the author (or first title word, if no author) so that your

reader can easilly find the complete citation for each of your in-text parenthetical references. 

Use a hanging indent to show the beginning of a citation. In other words, the first line of the citation

begins at the left margin and subsequent lines are indented ½ inch from the left margin.

Each entry in your bibliography must include at least the following elements, in this order: 

C The author’s (or authors’) full name(s).

C The date of publication.

C The title of the work (in “quotation marks,” italic, or underlined text).

C Source: The name of the magazine or newspaper, or the web address; for books, where the

book was published and the publisher. 

Other Notes:

C For publishers, give the city, as well as the state (or country if not in the U.S.) if the city is not

well known for publishing or is ambiguous. Omit superfluous terms like “Publishers,” “Co.,”

or “Inc.” but include “Press” or “Books.” 

C Use 2-letter (USPS) abbreviations for states. 

C Do not abbreviate “University.” 

C If two or more publisher locations are listed, give the first or the home office location if

known.

Rather than attempt to write out a formula for the various cases, I have given included common

examples below. They should be used as models. 

Book: One Author

Baumgartner, Jody C. 2000. Modern Presidential Electioneering: An Organization and Comparative

Approach. Westport, CT: Praeger.

Book: Two Authors

Miller, Warren E., and J. Merrill Shanks. 1996. The New American Voter. Cambridge, MA: Harvard

University. 

Book: Three Authors

Brown, James R., Sheila L. Jones, and Angus D. Rothman. 1991. The New European Century.

Cambridge, UK: Cambridge University. 

Book: More than Three Authors

Campbell, Angus, et al. 1960. The American Voter. New York: Wiley & Sons.
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The conventions for multi-authored works are the same regardless of whether it is a book, journal

article, etc. Most of the examples below are given as single-authored works. Refer to the section

above for cases with multiple authors. 

Edited Book (One Editor)

Barilleaux, Ryan J., ed. 1998. Presidential Frontiers: Underexplored Issues in White House Politics.

Westport, CT: Praeger.

Edited Book (Two Editors)

Baumgartner, Jody, and Naoko Kada, eds. 2003. Checking Executive Power: Presidential

Impeachment in Comparative Perspective. Westport, CT: Praeger.

Chapter in an Edited Book (One Editor)

Baumgartner, Jody C. 1998. “Electing Presidents and Other Potentates,” in Ryan J. Barilleaux, ed.,

Presidential Frontiers: Underexplored Issues in White House Politics. Westport, CT: Praeger.

Chapter in an Edited Book (Two Editors)

Baumgartner, Jody. 2003. “Comparative Presidential Impeachment: Introduction,” in Jody

Baumgartner and Naoko Kada, eds., Checking Executive Power: Presidential Impeachment in

Comparative Perspective. Westport, CT: Praeger.

Journal Article

Baylis, Thomas A. 1996. “Presidents Versus Prime Ministers: Shaping Executive Authority in

Eastern Europe.” World Politics. 48(3):297-323.

Magazine Article

Stephanopoulus, George. 1999. “The New Rules of the Road.” Newsweek. February 8, 1999. pp. 34-

35.

Newspaper Article

Chinoy, Ira. 1997. “In Presidential Race, TV Ads Were Biggest ‘96 Cost By Far.” Washington Post.

March 31, 1997. pA19.

Internet Article (Author and Date of Publication Included)

Thomas, Roger, and Susan Purdon. 1994. “Telephone Methods for Social Surveys.” Social Research

Update 8. Available at <http://www.soc.surrey.ac.uk/sru/SRU8.html>. Accessed May 2, 2004. 

Internet Article (No Author)

“Public’s News Habits Little Changed by September 11.” June 9, 2002. Pew Research Center for the

People and the Press. Available at <http://people-press.org/reports/display.php3?

ReportID=156>. Accessed May 4, 2004. 
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Internet Article (No Author, No Publication Date)

“The Biographical Directory of the United States Congress (1774-Present).” n.d. Available at

<http://bioguide.congress.gov/>. Accessed May 2, 2004. 

Unpublished Paper

Just, Marion R., and Todd L. Belt. 2004. “The Local News Story: Is Quality a Choice?”  Paper

delivered at the annual meeting of the American Political Science Association, Chicago, Illinois,

September 2-5, 2004.

Unpublished Dissertation or Thesis

Perez-Liñán, Aníbal S. 2001. Crisis Without Breakdown: Presidential Impeachment in Latin

America. Unpublished Doctoral Dissertation, University of Notre Dame. Notre Dame, IN. 

There are many other examples not included in the above list, including other internet situations,

government publications (agencies, hearings), newspaper articles from online an full-text database,

interviews (unpublished or published), encyclopedia articles, law cases (print or from full-text online

service), sound recordings, television programs, video recording, and a variety of other electronic

documents. Consult a librarian or the internet (which is full of resources for these matters) in the

event you have a question.
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VIII. Style: Other Issues

The following are various style issues that come up occasionally, in no particular order. 

1. Capitalize the first letter following a colon if the clause following the colon is a complete sentence.

2. When abbreviating any terms, spell them out the first time (in both the abstract and again in the

body of the manuscript, if need be). 

C Example: Date were collected from the General Social Survey (GSS) data set. 

Note: Do not use too many abbreviations. Whereas one, two, or three can be helpful, four or five can

be confusing.

3. Numbers: 

C The numbers zero through nine should be spelled out (except when it is a table or figure

number, or a metric measurement, etc.). 

C The numbers 10 and above should be written as numbers.

C Spell out any number when it is the first thing in a sentence. 

C Try to be consistent with number formats. That is, if you are reporting a series of related

numbers, they should all be presented with the same number of decimal places. 

4. Abbreviations: The following are several approved abbreviations for use in reference lists

C “chap.”: Chapter 

C “ed.”: Edition

C “Rev. ed.”: Revised edition 

C “2nd ed.”: Second edition

C “Ed.”: Editor 

C “Eds.”: Editors

C “Trans.”: Translated by

C “n.d.”: No date 

C “p.”: Page

C “pp.”: Pages

C “Vol.”: Volume (as in Vol. 3) 

C “vols.”: Volumes (as in 10 vols.)

C “No.”: Number 

C “Pt.”: Part

C “Suppl.”: Supplement 

5. Final Note: Various professors and publishers have different requirements for reference lists. Based

on the above, develop your own. The most important rule is be consistent!
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IX. Plagiarism

It would be impossible to stress too much the importance of knowing and understanding the rules

about plagiarism.

1. What Is It?

Plagiarism, simply, is stealing. If you use the words or ideas of others without giving proper credit,

you are a plagiarist. You should be concerned about plagiarism because it is a violation of most

college’s Code of Academic Conduct and may result in suspension or dismissal from school. 

“Intentional” plagiarism involves deliberate copying or use of another’s words or ideas. Importantly,

plagiarism can also be “unintentional.” In other words, “accidental” plagiarism is still plagiarism.

This usually is the result of not understanding the rules, so please be careful. My rule? When in

doubt, give credit to the source. To repeat: Even if plagiarism is unintentional, it is still plagiarism. 

2. Paraphrasing

Paraphrasing is an especially easy way to plagiarize, often without meaning to. See the following

example, where I illustrate what paraphrasing is. In the example, I give the original version and

follow it with a ‘paraphrased’ version, that is, in effect, plagiarism. 

Version #1, Original

The Russian Constitution grants the Russian president a broad range of potential presidential

decree power. In effect since December of 1993, the present constitution has been fairly labeled

“Yeltsin’s” Constitution. The legislature had no role whatever in drafting, debating, or ratifying the

document, having been forcibly disbanded in late September of that year. According to Article 90,

a presidential decree has the force of law providing that it does not contradict (1) the constitution or

(2) any existing statutes (and there are many holes in the Russian legal order). 

Version #2, Paraphrased: Plagiarized

The constitution of Russia gives a president a great deal of opportunity to use presidential decree

power. Adopted in December of 1993, the constitution is understandably known as “Yeltsin’s”

Constitution. Since the legislature had been dismissed in September of 1993, they played no part in

the writing, debating, or ratification of it. Article 90 states that as long as a presidential decree does

not contradict the constitution or any other existing laws it has the force of law. 

The lesson here is that you should summarize, not paraphrase

3. Conclusion

Even when you are not directly quoting material you must document any information and ideas you

use. If you are unsure, cite it: Better to be safe than sorry. 

Remember, whether it is intentional or not, plagiarism is wrong, and must be dealt with as such! 
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X. Writing Issues

Remember that you are writing a political science research report – a science paper. While writing, try

to imagine you are writing a textbook on, for example, physics. Ask yourself if the style of writing

you are using – your choice of words, phases, sentences — is appropriate for a book like that. Below,

I have listed a few guidelines to follow which will help you avoid some of the more common

mistakes people make in this regard. Above all, remember that you are writing a professional paper!

1. As a rule, you should not include explicit references to a particular class, what you have learned in

that class, what may have been discussed in class, etc. Some (few) examples of what to avoid: 

C “When I started writing this paper”

C “I have learned a lot from writing this paper”

C “When I first took this class”

C “As we discussed in class”

C “Our textbook says”

2. There is no place in a science paper (your paper) for the words “feel,” or “opinion,” as they relate

to beliefs, understandings, views, etc., of anyone (you or others). Do not use! Avoid making

judgements or expressing your opinions. This is, remember, science (imagine the following in a

physics text: “Gravity is really a terrible thing...”). Your opinions are, of course, important, but in this

class, it is not proper to include them in your research papers. Some phrases to avoid: 

C “I think”

C “I feel”

C “I believe”

C “This is good (bad)”

C “This is better (worse) than”

C “This is the best (worst) way to”

The simplest way to these style mistakes is to use the third person when writing. In other words, don’t

use first-person pronouns like “I,” “my,” “mine,” etc. This guideline will not cover all eventualities,

but is a good start. 

3. A paragraph that is longer one-half page is probably too long. If it is one page long it is definitely

too long. 

4. Other phrases that should be avoided: These phrases (seem to) sound good, especially to beginning

writers. However, they are often over-used, or worse, used when they should not be. Some of these

phrases include: 

C “As is well known” (nothing is “well known” in science — we do not assume anything); 

C “As we all know”; 

C “Obviously.”

5. In formal writing, do not use contractions (instead of “it’s” use “it is”), and avoid using slang. 
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6. “Never-say-neverisms” 

This list, originally 15 items, is by William Safire. It has since been added to, and was found at

<http://www.mapping.com/never2.html>. 

C Avoid run-on sentences they are hard to read.

C Don't use no double negatives.

C Use the semicolon properly, always use it where it is appropriate; and never where it isn't.

C Reserve the apostrophe for it's proper use and omit it when its not needed.

C Do not put statements in the negative form.

C Verbs has to agree with their subjects.

C No sentence fragments.

C Proofread carefully to see if you any words out.

C If any word is improper at the end of a sentence, a linking verb is.

C Steer clear of incorrect verb forms that have snuck into the language.

C Take the bull by the hand in leading away from mixed metaphors.

C Avoid trendy locutions that sound flaky - like, be aware that "like" is, like, easily misused.

C Try to never split infinitives.

C Never, ever use repetitive redundancies.

C Everyone should be careful to use a singular pronoun with singular nouns in their writing.

C I must have told you a million times to resist hyperbole.

C Also, avoid awkward and affected alliteration.

C “Avoid overuse of ‘quotation “marks” ’ .”

C Avoid commas, that are not necessary.

C A writer must not shift your point of view.

C And don't start a sentence with a conjunction.

C Don't overuse exclamation marks!!!!!

C Place pronouns as close as possible, especially in long sentences, as of ten or more words, to

their antecedents.

C Write all adverbial forms correct.

C Avoid un-necessary hyphenation.

C When dangling, watch your participles.

C It is incumbent on us to avoid archaic phrases.

C Never use a long word when a diminutive one will do.

C It's hard to imagine a phrase when you will have needed the future perfect.

C Unqualified superlatives are the worst.

C Last but not least, avoid cliches like the plague.

C A preposition is a terrible word to end a sentence with. 
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XI. Miscellaneous Notes

1. A Very Short Vocabulary Lesson 

C “Effect” is a noun, not to be confused with “affect,” which is a verb; 

C “Data” is the plural of the singular form of the word datum; therefore, we talk about “these

data,” or, “the data were” 

2. Spell Checking

Make sure you spell check your work. It is also necessary to check irregular or specialized words after

you spell check, since many terms that we use are specific to our discipline or may be capitalized.

3. Special Note to Microsoft Word Users

You must have a space after every punctuation mark, and the spell checker will not catch this. Notice

the difference between the ending quotation mark and the beginning parentheses in the following

examples: 

C Incorrect: “he was a big boy”(Smith, 1995) 

C Correct: “he was a big boy” (Smith, 1995)

4. The WWW and Graphics

It is not acceptable to cut and paste tables, charts, etc., directly from the World Wide Web.

5. Some Common Latin Abbreviations

C “e.g.”: for example 

C “i.e.”: That is

C “et al.”: And others


